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Important notice: 

This document is provided as a guideline and must not be disclosed without the consent of DediProg. 
However, no responsibility is assumed for errors that might appear. 

DediProg reserves the right to make any changes to the product and/or the specifications at any time 
without notice. No part of this document may be copied or reproduced in any form or by any means 
without prior written consent of DediProg. 
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I. General Description 
DediWare is dedicated programming software for StarProg engineering and ProgMaster, NuProgPlus mass 
production series programmers, providing the most user-friendly operation interface, users can easily 
perform engineering mode verification and mass production mode transfer under the same software 
environment. 

 
In engineering mode, DediWare provides basic programming settings such as Read ID, Read, Blank check, 
Program, Verify, and Batch. It can also be made into a programming project file (Project File, *.dprj) and 
loaded into the SD card, and converted to mass production mode. At the same time, it provides Standalone 
function. After loading the project file into the SD card, it allows you to program without a computer. 

 
In mass production mode, DediWare provides three programming methods, including manual, auto detect 
and handler modes. It also can control several programming devices simultaneously and individually to 
achieve the best productivity. In addition, it also provides the function of Unique key, which can generate 
serial numbers by loading files or software to satisfy the needs of programming serial numbers. Or through 
ATE Port external signal control (only for StarProg-A), making the production line arrangement easier and 
smoother. 

 

II. System Requirements  

2.1 Hardware Support 

⚫ Dual-core CPU or above 
⚫ 100GB Hard drive or above 
⚫ 1GB of RAM or above 
⚫ USB 2.0 

※ For eMMC or NAND IC programming , the faster hardware requirements the better.  

 

2.2 Operating System Requirements 

⚫ Windows 11 
⚫ Windows 10 
⚫ Windows 8.1 
⚫ Windows 8 
⚫ Windows 7 
⚫ Windows Server® 2008  
⚫ Windows Vista®  
⚫ Support both 32-bit and 64-bit OS 
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III.  Programmer Information 

3.1 Support IC 

DediWare software supports the following DediProg programmers. 
                      IC Kinds 
 
Programmer  
Model 

SPI  
Flash 

SPI 
NAND 

Parallel 
NOR/NAND 

Flash 
EEPROM MCU CPLD eMMC UFS 

StarProg-U ◎ ◎ ◎ ◎ ◎ ◎ ◎  

StarProg-A ◎ ◎  ◎ ◎ ◎   
K110 ◎ ◎  ◎     

NuProg-E2 ◎ ◎ ◎ ◎ ◎ ◎ ◎ ◎ 

ProgMaster-U4/8 ◎ ◎ ◎ ◎ ◎ ◎ ◎  

NuProgPlus-U8/U16 ◎ ◎ ◎ ◎ ◎ ◎ ◎ ◎ 
Note: StarProg-U only supports eMMC in the Engineering Mode. 

 

3.2 Multi-programmers Capability 

Same product model can be driven by one PC or notebook at the same time. The correct connection is 
shown in Fig. 3-1, the PC connected with all ProgMaster-U8 programmers. Fig 3-2 shown incorrect 
connection, since the StarProg and ProgMaster cannot be connected by 1 PC. 
 

 
Fig. 3-1 same model programmers can be connected by one PC 

 
Fig. 3-2 Different model programmers cannot be connected by one PC 
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3.3 Programmer and DediWare function 

According to different programmers, the function of DediWare is slightly different. Please refer the 

following table: 

               Software 
 

Programmer  
Model 

Engineering 
mode 

Production 
mode 

Unique 
key 

Stand 
alone  

LCD 
Keypad 

ATE Port 

StarProg-U ◎ ◎ ◎ ◎   
StarProg-A ◎ ◎ ◎ ◎  ◎ 

K110 ◎ ◎ ◎ ◎  ◎ 

NuProg-E2 ◎ ◎ ◎ ◎   
ProgMaster-U4/8 ◎ ◎ ◎ ◎ ◎  

NuProgPlus-U8/U16 ◎ ◎ ◎ ◎ ◎  
 

Information: 

A. StarProg series does not support production mode for eMMC (except for StarProg-U). 

B. StarProg series can support Standalone, please contact with DediProg if needed. 
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IV. DediWare Installation 

Purchase of StarProg, ProgMaster, or NuProgPlus series programmer, it will come with a quick guide, 

please scan the QR code and click download to get the latest DediWare version. 

 

4.1 Run DediWare software 

 
 

4.2 Save the installation files, as shown below. 
Path: C:\Program Files(x86)\DediProg 
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4.3 Select the “Install USB Driver” and “Backup DediWare”, as shown below. 
It is recommended to check “Backup DediWare” option to save the current DediWare version in different 
location.  

 
 

As shown below, install the backup in C:\Program Files\DediProg, which is different path with the original 
installation. 
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4.4 Programmer driver and DediWare software are installed successfully. 
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V. DediWare Introduction 

Before open the Dediware, install the programmer and the socket adaptors properly, turn on the 

programmer power, and wait for the operation system to recognize it. 

 

5.1 Open DediWare 

Choose the software according to your need, and double click the icon to start. 
 

A. DediWare General is for programming EEPROM, MCU, Parallel_NAND, Parallel_NOR, SD, 

SD_NAND, SPI_NAND, SPI_NOR. 

 
 

B. DediWare eMMC_UFS is for UFS and eMMC。 

 
 

C. DediWare CLI is for R&D using Command Line to communicate with the Dediware. 

 

 
 

 

Dialogue box will show the Client login message. Click OK to connect with Server. If an error message 

appears, please refer to VIII.FAQ  

 
   

 



            
 

 

 

岱鐠科技股份有限公司 

DediProg Technology Co., Ltd. 

DediWare Software User Manual 
V3.0 

10 

Professional Manufacturer of IC Programmer www.DediProg.com 

5.2 Software Interface 

 
 

5.2.1 Main menu 

 
 

A. Language: English, simplified Chinese, traditional Chinese, and Korean. 

 
 

B. Log in: The setting allows remote operation by the user. 
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C. General Options:  

⚫ It can set up the path for Buffer. Especially for large volume IC (For example, eMMC), since it 
needs more Buffer. If the default C drive does not have enough space, then it can save to 
other temporary space. 

⚫ It can set up where to save the Log File. If you have any related questions during the 
programming process, please provide the Log information to DediProg FAE. 

⚫ Set up the Security according to the programming need. It can set up a password to avoid 
the Project file been modified or misused. 

⚫ Enable the Multi-Voltage Verification. If needed, please check with DediProg to see whether 
the IC that is going to be programmed is supported. 

⚫ Checksum enables the calculation check and function; it only supports Intel HEX.S19. For 
customized demands, please contact with DediProg. 

⚫ Production mode operation enables the work order and save it in the summary report. 

 

 
D. Socket: Set and check the number of times the socket adaptor has been used (Need to enter 

the password in order to search). 

E. Normal mode: When opening an Encrypted Project file, it will be required to enter the 

password in order to enter the edit mode. 

F. AddOn:  

The Scan Bad Block function is for NAND flash use. User can check the Bad block location of 

NAND Flash (If there are more than 255 bad blocks. The status of total bad block will show “Too 

Many”). 

Besides, DediWare will check the first spare area location on the first page of each block is Non-

0xFF.  
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5.2.2 Help 

 
 

A. Download Default FPGA: It can improve the software speed when more than one programmer 

is connected to PC. The default has been set well before shipping to user. 

B. Base FPGA Manual Update(For Experts Only): Update the programmer (NuProgPlus) firmware, 

and the default path is C:\Program Files (x86)\DediProg\Firmware 

C.  Firmware Manual Update(For Experts Only): The default path of firmware file: C:\Program 

Files (x86)\Dediprog\Firmware  

D. LCD Firmware Update: This function is for upgrading the LCD keypad firmware if user has 

standalone dongle.  

E. Format Programmer’s SD card: It can format the content in the SD card without eject it. 

F. Reset Programmer Order: Reset the programming procedure. 

G. Launch Calculator: Opens Windows calculator. 
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H. User Manual: Dediware user manual. 

I. About DediProg: Dediware version. 

 
 

5.2.3 Toolbar 

 
 

A. Engineer Mode:  

The toolbar includes icons for quick access to most of the functions. 

Upper row- Select, LoadPrj, Load, Buffer, Config, Save Prj, IC Info, DownPrj 

Lower row- Read ID, Read IC, Blank, Erase, Program, Verify, Auto Batch 

Please refer to VI.Engineering Mode for detail introduction. 

 

B. Production Mode: 

Select Prj, Run Prj and Stop Prj. Please refer to VII.Production Mode for detail introduction. 

 
  

B. 

 

 A. 
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5.2.4 Programmer Status Window 
This area indicates that the status of each programmer. As shown below, there are status of two 

ProgMaster-U8 which including model name, firmware version and serial number (S/N). Site #1~8 shows 

status of each programming site. 

 
 

The Blink and Start function can only be set during production mode after downloading the project. 
A. Blink: All lights on the programmers will be on. Use when several programmers are connected. 

B. Up/down button : Set the orders of programmers. The top one is the first programmer. 

C. Start: When Start Mode is in manual, click start button to start the production programming. 

 
※The programming site status  

1. Unused or unselected 2. Idle site 3. Programming 

   
4.Programming successful 5.Progrmming failed  

  

 

*Please note that, DediWare software only accepts to connect the same programmer model at 
the same time. 
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5.2.5 Log Window 

 
 

A. Log Window:  

Log window records all progress information and steps, which will be saved to the installation folder 
automatically. 
Click “Save Log “to save as a new file. Click “Clear Log” to clean the log window and record to a new 
file. 

 
B. Check Sum:  

It shows the chip checksum. (The function does not support NAND and eMMC) 
⚫ Chip Checksum: Calculate the Checksum values of the entire chip that is programmable. 

⚫ Option Checksum: Calculate the Option parameters.  
⚫ File Check Sum:  

After downloading the programming file, the file checksum and file name will show in the table. 
Several files loaded at the same time will be shown in the table based on their priority. 

 
C. ProjectName / ProjectCheckSum:  

ProjectName is the name displayed after loading the project file; ProjectCheckSum is the project file 
Checksum calculated after loading the project file. When it is a project file, this information can be 
used for production management. 
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5.2.6 Information window 

 
 

A. Chip Info:  

⚫ Type: IC type 
⚫ Manufact: IC manufacturer 
⚫ Size: Memory size 
⚫ Package: IC package 
⚫ PartNum: Part number 
⚫ ID: Chip ID 
⚫ ADP P/N1~3: Socket adaptor part number 

 
B. Statistics:  

Statistics Window indicates the number of successful, unsuccessful (Failure), and total programmed 

chips. 

 

C. Batch Config Setting:  

Batch Config Settings contain information of batch and start mode setting. 
 

D. Software Status:  

Show DediWare current status. 
 

 
 
 
 
 
 
 
 
 
  

B. 

 

 

A. 

 

 

C. 

 

 

D 
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VI. Engineering Mode 
Engineering mode offers program, verify and test functions. Users can turn project file to the production 
mode for production. 

 

※Before using the software, ensure the socket adaptor has been installed properly and assign the one 

that you want to control. 

 

6.1 Select: Choose IC manufacturer/part number/package  

A. If the manufacturer is known, user can select the chip type and manufacturer directly. The 

related IC part numbers will show in the chip list. 

B. Search IC by typing IC part number in the field circled by the blue frame. It is recommended to 

choose “All” in the “Chip Type” and “Manufacture” to avoid limiting the search results. 

C. The input field has the memory function to store 5 sets of IC part number that can be selected 

by pressing the button on the right. 

D. Double-click selected IC in chip list. 

 
 
  

Search Input Field 
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E. The Log window will show the message as shown below after choosing the IC. 

 

 
 

F. IC information will also show in the ChipInfo window. 

 

 
 

 

6.2 Load Prj  
Able to load the Project File (*.dprj) that was saved in the Dediware. 
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6.3 Load   

Select “Load” to load the file intended for the programmer. According to different IC type, the file settings 

will divide into normal IC, eMMC and NAND Flash.  

 

6.3.1 Normal IC Programming Settings 
User can load one or several files at the same time, and set up the Buffer starting address, file offset 
starting address, and file length.  

 
A. File Format: The format of programming file. 

B. File Checksum: File checksum calculation method. 

C. File Offset: Set the address to start loading to buffer. 

D. File Path: Shows the path of programming file. 

E. Partition Name: If the IC has more than one memory that can be programmed, the partition 

names can be selected in this drop-down list (e.g. IC has Flash and OTP memory and the 

partition name list will have these two options).  

F. ChipCheckSum: Calculate method for the whole IC.  

G. StartProgAddr: Select the file to programmer Buffer. When loading several files to the same 

partition, make sure that the Memory Addr has been set well. 

H. ProgramLen: Set the file size for loading. 

I. FillUnuseByte: Check the box to assign Unused Byte. The default value is 0xFF. 

J. +: When the project file is bigger than one, click here to add and set up. 

K. ShowFileList/HideFileList: Open to search and close the file list. 
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Load File Steps:  

 
 

Step1: Click the button to open the load file dialogue box. 

Step2: Find the programming file. 

Step3: Confirm the parameter setting. 

Step4: Click “+” to add the file to the list. Repeat Step 1 to 4 to load more files. 

Step5: The file information will be shown on the list, and if there are any issues, find the 

corresponding file for modification. 

Step6: Click “OK” after checking all settings are correct. 

 

※ Once the error or warning message appears, please refer to VIII. FAQ 
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6.3.2 Load File Setting for eMMC 
User can load one or several files at the same time.  

 
A. File Format: The format of programming file. 

B. File Checksum: File checksum calculation method. 

C. File Offset: Set the start address to start loading to buffer 

D. File Path: Shows the path of programming file. 

E. Skip Blank Value: Check the box to check the blank data and skip the blank when programming. 

Reduce the programming time.  

F. Partition Name: eMMC offers UserArea, Boot1Area and Boot2Area. 

G. Sector index: Set the start address of eMMC sector. 

H. Sector count: The total number of programming sector. 

I. AutoSetFileOffset: When setting the Sector index, if you wish the File offset auto calculates, then you 

can select this function. 

J. +: When the project file is larger than one, then click “+” to add it to the setting list. 

K. Partition Table: You can use Partition Table to load multiple files for programming, but this is 

customized, please provide the IC Partition Table Specification to DediProg if needed. 

L. Export: Save various project file format, Checksum, path, and programming address as loadfilecfg file 

(Not include the file content). 

M. Import: Import loadfilecfg file, avoid entering the same programming file. 

N. Check Preload Max Size: Compare the total data size of all loaded file(s) with the expected data size. 

(This is customized, not recommended for general users) 

O. Show Images and Hide Images:  Open to search and close the file list. 
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Load File Steps for eMMC:  

 
Step1: Click button to open load file dialogue box. 

Step2: Find the programming file. 

Step3: Confirm the parameter setting. 

Step4: Click “+” to add the file to list. Repeat Step 1 to 4 to load more files. 

Step5: Files information will show in the “Image List” window, if not, click “Del” or “Reset” to restart 

setting. 

Step6: Click “OK” after checking all settings are correct. 

※ Once the error or warning message appears, please refer to VIII. FAQ 
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6.3.3 NAND Flash Programming Settings 

A. Use Partition File:  

Support CSV, DEF and MBN formats. CSV is Comma Separated Values Format, DEF is Group Define 
File Format, and MBN is Qualcomm Multiply Partition Format. If your partition file is one of these 
formats, you can choose this option for image file and partition file loading setting. 

 
B. Custom:  

Fully set up manually. 

 

 

a) Select “Custom” to set programming file. 

b) Load File for NAND Flash (From left to right): 

 
i. File Format: The format of programming file. 

ii. File Checksum: File checksum calculation method. 
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iii. File Offset: Set the address to start loading to buffer 

iv. File Path: Shows the path of programming file. 

v. SpareArea UseFile: Check the function to enclose the SpareArea with file. 

vi. Skip Last Empty Block: If the Block values are FFh continuously, then it will not load these 

Blocks if this option is selected. 

For example, there are 1024 Blocks (0~1023) in the chip, the Block Count of the loaded 

project file will be 1024. 

1. When Skip Last Empty Block is selected, and the Block 1000~1023 are all FFh, then it 

will not load these Blocks. 

2. When Skip Last Empty Block is selected, and the block 1000~1022 are all FFh, but 

Block 1022 is a non-FFh value, then it will not skip Block 1000~1022.  

vii. Partition Name: Only Flash option can be selected. 

viii. Block index: Setting the start of block. 

ix. Block count: Total block numbers for programming. 

x. AutoSetFileOffset: When setting the Block index, if you wish the File offset auto calculates, then 

you can select this function. 

xi. +: When the project file is bigger than one, click here to add and set up. 

xii. ShowFileList/HideFileList: Open to search and close the file list. 

 

c) NAND Load File Steps:  
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Step1: Click on the button to open the load file dialogue box. 

Step2: Find the programming file. 

Step3: Confirm the parameter settings. 

Step4: Click “Add” to add the file to list. Repeat Step 1 to 4 to load more files. 

Step5: Files information will show in the “Image List” window, if not, click “Del” or “Reset” to restart 

setting. 

Step6: Click “Next” after checking all settings are correct. 

※ Once the error or warning message appears, please refer to VIII. FAQ 

Step7: BBM Settings 
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A. BBM Configuration: 

Set it according to the number specified at Load File. As the above figure shown, there are multiple 
Image files need to set up EccAlgorithm, BBM, EccDataLayout, DataUnitSize, and MaxErrorBit. 

 

⚫ EccAlgorithm: ECC calculation. 
◆ If the “SpareArea UseFile” is selected on the “Load File-IMAGE” page, it will show: 

➢ Use File: It means the Image File has SpareArea data. 
◆ If the “SpareArea UseFile” is not selected on the “Load File-IMAGE” page, it will show: 

➢ It means the Image File does not have SpareArea data, and not using the ECC 
algorithm. 

➢ BCH8 MDM: This ECC algorithm is customized and protected by the NDA, 
therefore, the detail information cannot be provided. 

 
⚫ BBM: Bad block management. 

 
⚫ EccDataLayout: Provides 4 kinds of data layout. 

 
Use Page 2048+48 as an example 
Mode 0: 2048 + 64 
Mode 1: 512 + 16 + 512 + 16 + 512 + 16 + 512 + 16 
Mode 2: 512 + 512 + 512 + 512 + 16 + 16 + 16 + 16 
Mode 3: 2112 

 

※ Note: If the Mode0~2 ECC area appears Bit Error, the orange block, then verify will fail. 

 
⚫ DataUnitSize: According to the data layout to set the data unit size. In this case, 2112 Byte is 

used as the unit. 
 
⚫ MaxErrorBit: According to the data unit to set the maximum error bit of each unit. In this 

case, for 2112 Bytes, 1 bit error is allowed. 
 

EccDataLayout, DataUnitSize, and MaxErrorBit are for verification, which will analyze the data 
accuracy and filter Bit Error to ensure the IC will work normally on board. For example, when ECC 
needs 528/2bit for CPU, then set EccDataLayout as Mode 3, DataUnitSize as 528Bytes, and 
MaxErrorBit as 2bit. If you want to filter the NAND Flash more strictly, set the MaxErrorBit to 1 bit. 
The default setting will depend on the Datasheet definition.  

  
※Note: If the part number is XXXX_Ecc (IC number with _ECC), then IC will turn on the Internal 

ECC, which should not have Bit Error. Therefore, MaxErrorBit will be invalid. 
  
 
 
 



            
 

 

 

岱鐠科技股份有限公司 

DediProg Technology Co., Ltd. 

DediWare Software User Manual 
V3.0 

27 

Professional Manufacturer of IC Programmer www.DediProg.com 

B. Guarded Area Configuration: 

For setting NAND Flash bad block. In this case, first, Guarded Area Index is 0; Block0 to Block9 do not 
allow bad block. Second, Block 10 to Block 999 can allow 10 bad blocks. If one of these two 
conditions is met in the programming process, this IC will be considered as a failed IC. 

 
 

⚫ Load Guarded Area Table: Able to load the Guarded Area Table in Qualcomm Multiply 
Partition Format. 

 

Note:  
NAND Flash programming function includes the BBM and ECC setting. If user cannot find the suitable 
BBM and ECC for programming setting, please contact DediProg. 
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6.4 Config Setting  

6.4.1 Batch Settings 

Double-click or click  to select options or click  to remove. 

 
 

6.4.2 Option Setting 

A. Default Check (Please contact DediProg): It is to confirm whether the IC has been programmed 

depends on the IC kinds. Please contact DediProg if needed. 

B. StartMode Setting: To meet user needs, DediWare offers three production modes. 

⚫ Start from Manual Mode:  
Production mode will be activated by click “Start” on GUI or press the start button on 
programmer. 

⚫ Start from Auto Detection:  
DediWare will detect inserted chip and start to program automatically after running the RunPrj. 

※ StarProg-ATE / NAND / eMMC does not support this function. 

⚫ Start from Handler: This function is suitable for DediProg automatic system. 
C.  Main Clock: SPI Clock speed 

D.  Read IO Mode: SPI Protocol’s IO Mode (Default Single). If you need Dual or Quad, please 

contact DediProg. 

E. Program IO Mode: SPI Protocol’s IO Mode (Default Single). If you need Dual or Quad, please 

contact DediProg. 
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Note:  
Programmer has the auto IC contact testing function in manual and auto detection mode. Users must 
take out the IC from the socket adaptor after programming. Please refer to VIII. FAQ 

 
 

6.4.3 Unique Key Setting 
DediWare has two kinds of Unique key for programming the key in the IC. One is loading the serial 

numbers file to program; another is to give the random key from DediWare automatically. 

※Please note the Unique key only can be used in production mode. 

 
A. Enable program unique key to different chips: The Unique key will be activated automatically 

in the production mode. 

B. Partition Name: Assign the partition of programming. 

C. Start Address: Assign the start address of programming (Hexadecimal). 

D. Length: The length of unique key. 

E. Address Mode: Choose 8bit or 16bit for the address. 

F. From unique key File:  

⚫ Sample key file: Read the length of key after load the file. 
⚫ Reuse the failed keys: Reuse the failed key when the unique key programming failed. 

G. From serial number:   

⚫ Byte Order: Select the key number order is by Big Endian or Little Endian. 
⚫ Step: The serial number cumulative value. Default is 1, ex: 0000, 0001, 0002, etc. 
⚫ Enable roll serial number function: If the numbers over the setting range, reuse from the 

first number again. 
H. From serial number for muti-address:   

⚫ Byte Order: Select the key number order is by Big Endian or Little Endian. 

http://en.wikipedia.org/wiki/Hexadecimal


            
 

 

 

岱鐠科技股份有限公司 

DediProg Technology Co., Ltd. 

DediWare Software User Manual 
V3.0 

30 

Professional Manufacturer of IC Programmer www.DediProg.com 

⚫ Step: The serial number cumulative value. Default is 1, ex: 0000, 0001, 0002, etc. 
⚫ Multi-Address: Able to choose multiple starting address. 
⚫ Enable roll serial number function: If the numbers over the setting range, reuse from the 

first number again. 
I. From Others: This is a customized option, please contact DediProg if needed. 

※ For more Unique key instructions ,please download the Unique key user manual from 

DediProg website. 

 

6.4.4 Other functions of Config 
6.4.4.1 Enable Force Erase only for NAND Flash 

 

In order to fix the bad block issue of NAND Flash. If Batch setting includes Erase Blank, Program and Verify 

then the software will show the check box asking for force erase.  

 

A. Disable Force Erase: Read ID→ Software produce BBT (Bad Block Table) →Erase and Blank will 

do “SKIP” by BBT →Program and Verify will process based on BBM setting. (Default value is 

“SKIP”) 

B. Enable Force Erase: Read ID→ Erase all (include Bad Block) → Software produce BBT (Bad Block 

Table) → Blank will do “SKIP” by BBT→ Program and verify will process based on BBM setting. 

(Default value is “SKIP”) 

 

  



            
 

 

 

岱鐠科技股份有限公司 

DediProg Technology Co., Ltd. 

DediWare Software User Manual 
V3.0 

31 

Professional Manufacturer of IC Programmer www.DediProg.com 

6.4.4.2 Option Setting 

A. Config will offer optional settings base on different IC types. In this case, it is showing the 

option setting for MCU (STM32F030CT6). 

 
 

B. For eMMC type of IC, set up ExtCSD in the Config Option, for example, the below is THGAMRT0T43BAIR 

from TOSHIBA. 
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6.5 Programming function 

In the Engineer Mode, no matter how many socket adaptors on the programmer, it only can set one 

programmer in the same time. Please make sure the programming site is specified for use. (e.g. site#2). 

 
 

6.5.1 Function for single Socket Adaptor  

A. Read ID: If IC has ID can be read and shows in Log windows and the ID can shows in ChipInfo. 

B. Read IC: Read the IC data and compare with the file data. 

C. Blank Check: Check if the target chip is blank or not. 

D. Erase: Erase whole IC or specific area If IC has several partitions. 

E. Program: Write the selected file data into the chip. 

F. Verify: Content verification between chips and loaded file. 

G. Auto Batch: Run the programming settings of batch in Config. 
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6.5.2 Function Activation Timing 

 
 
Function 

Not select IC Selected IC 
Selected IC 

And load project 

Selected IC, load 
project, setting 
Config/Batch 

Read ID  ✓ ✓ ✓ 

Read Memory  ✓ ✓ ✓ 

Erase Whole Chip  ✓ ✓ ✓ 

Blank Check  ✓ ✓ ✓ 

Program Chip   ✓ ✓ 

Checksum Verify   ✓ ✓ 

Auto Batch    ✓ 

※When running the project programming, the single socket function will be disabled.  

 

6.5.3 Read IC  
Windows is shown below. It’s the example for eMMC programming. 

 
 

A. Area Select    

If the selected IC has parts of memory, the user can switch the memory area after Read memory. 

The area function is eMMC in this case. 

B. File Window (Buffer)   

Files contents will be displayed in this area.  

C. Chip Window 

Chip contents will be displayed in this area. The data will automatically compare with file data and 

show the differences in red color.  

A. 

 

 
. B 

 

 

. C 

 

 

. D 

 

 

Action 

. E 

 

 

. F 

 

 
. G 
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D. Buffer Checksum and Chip Checksum 

Provide the Buffer Checksum and Chip Checksum functions for the assigned Partition, which makes verify 

easier. 

E. Goto  

User can assign DediWare go to the address that user wants to examine by entering line number 

into the column. 

F. Save 

Save the chip data for each partition.  

G. Next Different    

DediWare will indicate the differences between the loaded file and edited file. 

 

6.6 Buffer   
Data will be saved in the buffer after loading file. Check the data is correct address here. 
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6.7 Save Project  

After Load File, Config settings and verification, DediWare is ready to save the project for production 

usage. Click SavePrj and the window shows below, click OK to save the file. 
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6.7.1 Set up password for the project file. 
A. Set protected mode of software after loading of this project file:  

The encrypted project file can only be modified after entering the password in Advance-> Normal mode 
 

 
 

B. Encrypt project file (with password):  

Please enter the password for the encrypted project file in order to view the content. 
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VII. Production Mode 

After setting up the related settings in engineering mode, it can be created as a project file for production. 
The Production functions are as below: 

 
A. SelectPrj: Select the project in the SD Card. 

B. RunPrj: Run the project. 

C. StopPrj: Stop the project. 

General Steps: Load project > Select Project > Run Project > Stop Project 
 

7.1 SelectPrj: Download and select project.  

※Ensure SD card is inserted to the SD card slot before downloading the project file. Strongly recommends 

use the Industrial SD card with high reliability and Stability from DediProg. 

Select the file from the computer  or the SD card in the programmer , and click OK. The project on the 
computer can be loaded to the SD card in the programmer.  Please ensure the SD card is inserted in the programmer 
correctly before executing. 
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After selecting the file, the window will show IC information, batch setting, Start Mode, File Checksum, 

ProjectName and ProjectCheckSum. 

 
 

Click “Blink” to check the programmer order is correct.  

 

Note： 

If the project file that you are going to use is already in the SD card, then you don’t need to 
select it from the PC again, simply need choose it from the SD card. Because, if you choose it 
from the PC, it will transfer through the USB, which will waste a lot of time, especially for large 
volume IC. 
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7.2 Run Project   

DediWare will detect each programming site status after clicking “Run Prj”. If there is no socket adaptor on 

the site, the log window will show in yellow color. When programmer is ready for production, DediWare 

will program as user setting before. 

 
A. Start from Manual Mode:  

Production mode will be activated by click “Start” on GUI or press the start button on programmer. 

  
B. Start from Auto Detection:  

DediWare will detect inserted chip and start to program automatically after running the RunPrj. (This 
function does not support eMMC and NAND Flash) 
C. Start from Handler: This function is suitable for DediProg automatic system. 
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Image of Start from manual mode for production 

 
 

7.3 Stop Prj   

Click “Stop Prj” to stop project programming. The programing result will show in Log window as below.  

 
 

※ When it is finished, DediWare will automatically generates a summary report in the Log File, which 

helps to manage the production easily. 
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7.4 Use unique key in production 

If user need to program unique key when production. Must set and enable the unique key in Config setting 

before make a project file. The advance setting menu will show up when user selects the project file and 

run project.  

 

DediWare provides three methods to use the unique key. 

 

7.4.1 Unique key Mode: Use the unique key file. 
The information and parameter of Config unique key setting will show here. Only need to select the path of 

file.  

 
Besides, there are three folders will be installed here automatically after select key file. 

A. Failed: Unique key programming failed folder. 

B. Uc-log: Save log file when program Unique key. 

C. Used: Unique key programming successful folder. 

 

7.4.2 Serial number mode: The unique keys will be produced by DediWare 
The information and parameter of Config unique key setting will show here. Only need to set the format 

(HEX / DEC / BCD) of serial numbers, start and end number.  
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VIII. FAQ 

Q1. What to do if these messages appear when opening DediWare? 

1. There are several reasons might cause “Plug in new programmer or the order has changed”. 

 

⚫ The orders of programmers may have been changed, restart DediWare. 
⚫ Computer does not detect any programmer, check the power of the computer. 
⚫ USB disconnected. 

 

2. If it appears “Query Device info failed or count is zero”, please check the below items.  

 

⚫ Check the power of the programmer. 
⚫ Computer does not detect any programmer, check the power of computer. 
⚫ USB disconnected. 
⚫ Check if the USB driver has been installed. 
⚫ Programmer firmware does not match DediWare software. Please update the DediWare 

version. 
 

3. If it appears “DediNet_SetChipInfo failed, err:Alloc memory fail”, Please contact DediProg. 
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4. This means the programmer Firmware only supports older DediWare version. Please upgrade the 
Firmware and restart the DediWare. 

 
 
Q2. After insert the socket adaptor, the programmer cannot detect the adaptors nor execute any 
programming function. 

The socket adaptor might have crashed, please select  Advance＞Socket＞Socket count to confirm the 

socket adaptor information. If socket adaptor does not show any following information, that means it is 
disconnected or the control IC of the socket adaptor has been damaged. Please contact DediProg. 

 
 

Q3. Programmer doesn’t detect the socket adaptor on the programming site after running project? 
Please refer to Q2 to check the socket information. Maybe socket adaptor is disconnected or control IC is 
broken. 
 

Q4. Do I have to pay extra fee to upgrade my DediWare or programmer firmware? 
DediProg offers FREE software and firmware update once user bought StarProg, ProgMaster, or 

NuProgPlus series programmers. User can download the latest software on DediProg website. StarProg-

ATE, which has been EOL, only provides online programming functions, please contact DediProg if needed. 

 

Q5. How to upgrade my programmer firmware? 
New DediWare version (3.x.x) must be used with 2.x.x firmware version. 

1. If firmware version is 1.x.x，please refer to the following steps for update. 

Step 1: Install the new version of DediWare and the firmware (2.x.x) will be in the installation folder. 
(Default path: C:\Program Files (x86)\Dediprog\Firmware) 
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Step 2: Close the new version of the DediWare and open the old version. 
Step 3: Go to Menu > Help > Firmware Manual update the firmware to 2.x.x version. 
Step 4: Turn off the programmer for about five seconds and restart it, and open the new DediWare to 

confirm the firmware version. 
 
2. If the firmware version is 2.x.x already. 

The pop-up message shown below occurs when user opens DediWare after installing the new version 
of DediWare. Please update firmware with the following steps.  

 
Step 1: Go to Menu > Help > Firmware Manual Update and select firmware (2.x.x) to update. The new 

firmware file will be saved to the installation folder. 
Step 2: Turn off the programmer for about five seconds and restart it, and open the new DediWare to 

confirm the firmware version. 
 
Q6. Warning message appears when loading files? 

1. It means the selected file size is bigger than partition size. Press OK will truncate the file to fit the 
partition space. However, DediWare does not check the data importance.  

 
 

2. When the user loads several files that will overwrite the old files, please make sure the size and 
memory address of each file will not overlap each other. 
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Q7. “Download Project failed, error:sdcard not plug in” appears when running production mode? 

 
1. Please check if the SD card is installed in the SD card slot properly. 
2. Check if the SD card is broken. 
3. Please turn off the power before inserting the SD card. 
※Strongly recommends use the Industrial SD card with high reliability and Stability from DediProg. 

 
Q8. About contact testing  
DediWare supports contact testing when using auto detection or manual mode for project programming. 

Contact testing can reduce the mistake made by the operator. The operation steps are showed below. 

Step 1: The lights of original programmer status are all off. 
Step 2: Start programming. The orange light turns on. 
Step 3: One of the successful green light or fail red light will turn on after programming. If the user 

presses the start button by accident, the programmer will not work while the IC is still in the 
socket. 

Step 4: All lights will turn off after picking up the IC.  

 
Contact testing will start working after executing the “RunPrj”.  
 

Note:  
If user only press the socket down, but not picking up the IC (Step 3), the programmer will determine 
that IC has been picked. Contact testing only checks the IC and socket connection, but not detecting if 
the IC has been programmed or not. User can use DediWare to check the IC programming status. 
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Q9. Log shows “Contact Fail” when programming? 

1. Check IC number and manufacturer is correct.  

2. Check socket adapter model name is correct. 

3. Confirm the socket adaptor connection. 

4. Update the software version. 

Q10. Log shows “Erase Fail” when erase NAND Flash? 
Too many bad blocks may cause this issue. Please go Config>Batch>Erase>Enable Force Erase. Use batch to 

do all erase and check the log. Nand Flash user manual is available on DediProg Website.  

 

Q11. Programming succeeded, but cannot work on the motherboard?  
Exclude the cold solder problem on motherboard, you can also check software setting:  

1. Check programming file, unused byte setting, file format and offset address. 

2. If IC has multiple partitions, make sure do not miss any partition hat needs programming. 

3. Check if there are any missing settings for the Option. 

 
Q12. About Checksum? 
DediWare has four kinds of Checksum, File Checksum, Chip Checksum, Option Checksum, and Project 

Checksum. 

There are twelve types of File Checksum can be selected when setting the “load file”.  

 
The red frame as below shows the File Checksum after loading file. The blue frame is Chip Checksum. The 

green frame is the Option Checksum, and the orange frame is the Project Checksum. 

 
 

Chip Checksum is the calculation of total IC memory that can be programmed. If IC has Flash and EEPROM, 

Chip Checksum will make summary of those contents. Please notice the file size and format for Chip 

Checksum, Binary data are connected but Hex/S19 are decentralized data. Therefore, setting Unused Byte 

will affect the summary of Chip Checksum. 
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Setting the Unused Byte when Load File. The default value is “0xFF” if user did not set the Unused Byte.  

 
 
Other than programming the IC memory, there are special Options available (Ex: Config setting for SPI 
NOR), and for the correctness of the production, DediWare also provides Option Checksum (Green Frame) 
for comparison and Project Checksum (Orange Frame) to verify the Project File that was used in the 
production in order to reduce the risk. 
 
Q13. What to do if it shows “Login failed, please try again”? 

 
This could happen when the computer has low efficiency, since Dediware is Server/Client structure, 
combination of two executable files. When this warning appears, go to the installation directory  

⚫ The Server is in the installation directory, DediProg > Server > DediProg_bg.exe 
⚫ The Client is in the installation directory, DediProg > Client > DediProg.exe 
 
Q14. How to add the newly supported IC without update the software? 
Please contact DediProg for “DediProg Config Update” file. When executing this file, it will update the 
latest supported IC to the software. 
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Q15. How to use DediWare Selector? 
If you want to use different DediWare version, there is a DediWare Selector, shown as below. 
The file location is C:\Program Files(x86)\DediProg\ DediWare Selector 

 

 
 

Choose Dediware Backup path, and it will show the backup DediWare version.  
Choose the needed version, click OK and open DediWare. 
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Note: The software is backward compatible only, for example: If the software is 3.17.4.1, and then it can 
open the 3.16.32.1 version file, but if the software is 3.16.32.1, it can’t open 3.17.4.1 version file. 
 

IX.  Revision History 
 

Date Version Change 

2013/08/28 1.0 Initial release 

2014/05/26 1.1 
⚫ Remove MCU Prog / StarProg ATE(Flash) 
⚫ Separate StarProg to StarProg-F and StarProg-U 

2014/07/29 2.0 New DediWare software release 

2014/11/28 2.1 Update the GUI. 

2015/04/07 2.2 Remove 7.4 CLI & API Control 

2022/03/30 3.0 
1. Layout Arrangement 
2. Add new function 

 
 
 
 
 
 
 
 
 
 
 
 
 
DediProg Technology Co., Ltd. (Headquarter)  
4F., No.7, Ln. 143, Xinming Rd., Neihu Dist., Taipei City 114, Taiwan 
TEL: 886-2-2790-7932   FAX: 886-2-2790-7916  
 
Technical Support: support@dediprog.com   Sales Support: sales@dediprog.com 
 
Information furnished is believed to be accurate and reliable. However, DediProg assumes no 
responsibility for the consequences of use of such information or for any infringement of patents or 
other rights of third parties which may result from its use. Specifications mentioned in this publication 
are subject to change without notice.  
This publication supersedes and replaces all information previously supplied.  
 

All rights reserved 
Printed in Taiwan. 

mailto:support@dediprog.com
mailto:sales@dediprog.com

